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1 Introduction

1.1 Product Description

Backup4all  is  an  award-winning  backup  software  for  Windows.  Backup4all  protects  your
valuable  data from partial or total loss by automating backup tasks, password protecting and
compressing  it to save storage space. Using Backup4all you can easily backup to any local or
network drive, backup to FTP (with support for SSL encryption, proxy server, passive mode),
backup to CD/DVD, or other removable media (such as USB drives).

 

Backup4all  can backup open/locked files and it can perform full, differential,  incremental and
mirror  backups. When defining a backup you can also set file filters and schedule the backup
for  automatic  execution.  Once  a  backup  is  performed,  you  can  see  what  files  have  been
changed  since the last backup or you can read the statistics about the next backup execution.
You can use the context  menu from the tree to run standard actions associated with the file
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type.
 
There  is  also the option to run predefined backups,  such as  My Documents,  My  Pictures  or
Outlook Express emails and settings.
 
Backup4all  has ZIP64 support (can create backups over 2 GB) and creates standard zip files,
meaning  that you can access it with any zip compatible utility. Backup4all also allows you to
encrypt your backup using AES encryption (128/192/256-bit).
 
Backup4all  keeps track of file versions. You can easily restore any version of files or a whole
folder. You can filter files to be restored.
Backup4all  tests  the  backup  files  automatically  to  ensure  the  backup  is  safe  and  correctly
executed (uses CRC32). You can also enable email notifications to receive an email in case of
success/error/warning.
 
Backup4all  works with any drive letter, including mapped network drives and UNC paths. It
comes with its own built-in CD/DVD burning support. However, if you prefer, you can use the
UDF format.
 
Backup4all  runs  on  Windows  98/Me/NT/2000/2003/XP/Vista  and  offers  multi  language
support.

1.2 System Requirements

To install  Backup4all  you  need  Windows  98/Me/NT 4.0/2000/XP/Server  2003  or  Windows
Vista  and  at  least  20  megabytes  of  free  disk  space.  Installing  additional  language  files  may
increase the space requirements.
 
Because  the  application  uses  zip  compression,  additional  disk  space  is  needed  for  the
temporary directory. The amount of free space depends on the size of files to backup.
 
Note:  Backup4all  can  backup  open  files  only  if  installed  on  Windows  XP,  Windows  2003
Server  or  Windows  Vista  and  if  the  files  are  on  NTFS  partitions.  Backup4all  works  on
Windows 98/Me/NT 4.0/2000 too but this feature will not be available on these systems.
 

1.3 Installation

Install
 
To install  Backup4all  on a  computer  you need to have administrative  rights.  The installation
process  does  not  take  much  time.  All  you  need  to  do  is  to  follow  the  instructions  of  the
Backup4all  Setup Wizard.  There is no need to reboot at the end of the setup, you can run
the program right after it is installed on your machine.
 
If you have already installed an older version of Backup4all, you can install the new version on
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top  of  the  older  one,  no  need  to  uninstall  it  (the  installer  will  recognize  if  the  program  is
running  and  ask  if  you  wish  to  close  it  in  order  to  continue).  You  might  need  to  close
Backup4all  manually if it is in a middle of an operation.
Note:  If  you  have  version  2.x  (or  previous)  installed,  you  can  install  version  3.x  without
uninstalling  the other one. Backup4all 3 will  be installed and run separately, and will give you
the option to import your backup jobs/groups from the previous versions.
 
When  you  start  the  installation  process  you  will  be  prompted  to  choose  a  language  for  the
setup wizard. Later during the setup you can check to install other language files too. If you
install  multiple  language  files,  Backup4all  will  use  the  selected  language  as  the  default  one.
After installation, to switch between them, go to Backup4all's menu, select Tools->Options-
>Language.
 
Steps during installation:

1) Select  setup language  -  you need to choose from the drop-down box a  language  for
the setup wizard

2) Setup welcome message - press Next to continue
3) License agreement - shows the Backup4all EULA. After you read and accept it, check

the I accept the agreement option and click Next to continue.
4) Destination location - gives you the option to select a folder where Backup4all will be

installed.  By default it creates an entry in the Program Files directory.
5) Start menu folder - lets you select where to place shortcuts in the Start Menu folder
6) Select  default  settings  -  lets  you select  if  you want  to  have  the  settings  (and  backup

jobs)  kept  different  for  each  users  (Current  User)  or  shared  for  all  users  (All  Users).
Also  it  allows  to  override  the  location  of  the  default  destination  and  folder  where
settings will be kept.

7) Select additional tasks
i) Create a desktop icon - checked by default, places a shortcut on desktop
ii) Associate  Backup4all  3  with  the  ".bkc"  extension  -  checked  by  default,  will

associate  the  .bkc  files  with  Backup4all  (".bkc"  are  catalogs  created  by  Backup4all
after each backup)

iii) Start  on  Windows  startup  -  if  checked  Backup4all  will  load  each  time  Windows
starts

iv)Create  a  Quick  Launch  icon  -  checked  by  default,  places  an  icon  in  the  Quick
Launch toolbar

v) Start 'One Touch Backup' Agent
vi)Allow restricted users to use the CD\DVD writer devices  - if checked it will  give

access to users with restricted rights to select CD/DVD as destination
vii)Start  the  Volume  Shadow  Service  -  checked  by  default,  the  VSS  is  needed  by

Backup4all  to perform open files backup (usually this service is started by Windows,
so if this option is checked Backup4all will verify if is started and if not it will start it)

7) Select default backup folder - select a folder where backups will be stored by default
8) Blank Scheduler Password - if checked it will allow blank passwords when scheduling
9) Select  languages  for  the  interface  -  you  can  check  to  multiple  languages  for

Backup4all's  interface
10)Select  default  interface language  -  if  multiple  languages were selected,  you need to
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select a default one
11)A summary is displayed and in the last window click on Install to start the installation.

Uninstall
 
To uninstall  Backup4all,  first  you  need  to  close  the  application.  Then  go  to  the  Backup4all
application  group (from the Windows Start  -> Programs -> Backup4all  3  menu and  click
Uninstall).
You  can  also  uninstall  Backup4all  using  the  Add/Remove  Programs  option  from  Start-
>Settings->Control Panel.
 

1.3.1 Command Line Parameters

Installing Backup4all with command line parameters
Backup4all  can  be  installed  with  various  command  line  parameters  that  are  useful  when  an
unattended installation is needed.

Syntax
          b4aOTB.exe [switches]

Switches can be any combination of the following parameters:

/SILENT  - Instructs Setup to be silent. When Setup is silent the wizard and the background
window are not displayed but the installation progress window is. Everything else is normal so
for example error messages during installation are displayed. If a restart is necessary and the /
NORESTART  command isn't used (see below) and Setup is silent, it will  display a "Reboot
now?" message box.

/VERYSILENT - Instructs Setup to be very silent. When a setup is very silent the installation
progress  window is  not  displayed  and  if  a  restart  is  necessary  it  will  reboot  without  asking.
However the error messages during installation are displayed.
 
/SUPPRESSMSGBOXES  -  Instructs  Setup  to  suppress  message  boxes.  Only  has  an  effect
when combined with /SILENT and /VERYSILENT.
 
/NOCANCEL - Prevents the user from cancelling during the installation process, by disabling
the Cancel  button and ignoring clicks  on  the  close  button.  Useful  along  with  /SILENT  or  /
VERYSILENT.
 
/DIR="x:\dirname"  -  Overrides  the  default  directory  name  displayed  on  the  Select
Destination Location wizard page. A fully qualified pathname must be specified.
 
/GROUP="folder  name"  -  Overrides  the default  folder  name  displayed  on  the  Select  Start
Menu Folder wizard page.
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/LANG="language" - Specifies the language to use for the installation. When a valid /LANG
parameter is used, the Select Language dialog will be suppressed.
 
/CURRENTUSER=[YES|NO]  - Specifies  if the settings for Backup4all  will  be used for  the
current user only (YES) or for all users (NO)

/SETTINGSFOLDER="DEFAULT|<PATH>"  -  Specifies  the  path  of  the  folder  where
program's settings will be kept. If DEFAULT is selected, the path will be "C:\Documents and
Settings\<CURRENT  USER  NAME>\Application  Data\Softland\Backup4all  3\"  (same  as  if
<PATH> would be empty). Otherwise if a full path is entered that will be where the settings
folder will be kept.

/TASKS = "comma separated list of task names"  - Specifies a list of tasks that should be
initially  selected or deselected. To deselect  a  task,  prefix  its  name with a  "!"  character.  Only
the specified tasks (and their  children)  will  be selected;  the rest  will  be deselected.  Use the /
MERGETASKS parameter instead if you want to keep the default set of tasks and only select/
deselect some of them.
Task names:
 desktopicon - Create a desktop icon
 associate - Associate Backup4all with the .bkc file extension
 autostart - Start on Windows startup
 quicklaunchicon  - Create a Quick Launch icon
 startotbagent - Start 'One Touch Backup' Agent
 addburnright - Allow restricted users to use the CD\DVD writer devices
 startVSS - Start the Volume Shadow Service (Needed for open file backup)

 
/MERGETASKS="comma separated  list  of  task  names"  -  Like  the  /TASKS  parameter,
except the specified tasks will be merged with the set of tasks that would have otherwise been
selected by default.
 
/DefaultBackupDest="x:\dirname"  - Overrides the default directory name displayed on the
Default Backup Folder wizard page. A fully qualified pathname must be specified.
 
/Languages="language1-language2-..."  -  Specifies  the  languages  that  will  be  installed.
Language  codes available  in  the current  version:  ITA, CHS, CHT,  CSY,  DAN,  DEU,  ELL,
ESP, FRA, ITA, JPN, NL, NO, PLK, PTB, ROM, RUS, SV, TRK.
 
/DefaultLang="language"  - Specifies the default language. Language codes available  in the
current  version:  ITA, CHS, CHT, CSY, DAN, DEU, ELL, ESP,  FRA, ITA, JPN, NL, NO,
PLK, PTB, ROM, RUS, SV, TRK
 
/RegisterName="registration name" - Backup4all registration name
 
/RegisterKey="license key" - Backup4all Registration key
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/NoInstallIfExists  - Instructs setup to check if the "Backup4all" is already installed, and if it
is, does not start the installation

Uninstalling Backup4all with command line parameters
The uninstaller has also some parameters for silent uninstall.

Syntax
          unins000.exe [switches]

Switches can be any combination of the following parameters:
/SILENT  -  Instructs  uninstaller  to  be  silent  during  uninstallation.  When  Setup  is  silent  the
wizard and the background window are not displayed but the uninstallation  progress window
is. Everything else is normal so for example error messages during uninstallation are displayed.

/VERYSILENT  - Instructs uninstaller to be very silent during uninstallation. When a setup is
very  silent  the uninstallation  progress  window is  not  displayed.  However  the  error  messages
during uninstallation are displayed.
 
/SUPPRESSMSGBOXES  -  Instructs  uninstaller  to  suppress  message  boxes.  Only  has  an
effect when combined with /SILENT and /VERYSILENT.

1.4 Notice to Backup4all 2 Users

Backup4all 3 brings new features and enhancements improving its overall functionality:
 Backup  to  FTP.  You  can  now  backup  your  files  to  remote  locations  using  the  FTP

service (with SSL support, active/passive transfer modes, firewall support).
 Email  notifications.  You  can  configure  Backup4all  to  send  custom  emails  after  a

finished  backup with success, error, warning notifications. Additional options allow you
to attach the backup log file and send the email to several addresses.
 AES  encryption.  Backup4all  supports  128-bit,  192-bit  and  256-bit  AES  encryption.

These numbers reflect the encryption key size used to encrypt the data, thus a higher key
size provides stronger encryption.
 Backup locked or open files.  Backup4all  uses  the Volume Shadow Copy service that

allows you to back up local open files from NTFS partitions in Windows XP/2003/Vista.
Now  you  can  backup  your  emails  and  settings  without  closing  Microsoft  Outlook,
Outlook Express or other email clients.
 Predefined  backups enhanced.  You can  now easily  define  a  backup  job  for  Outlook

Express emails and settings from the predefined backups list.
 Delete sources after successful backup.  Backup4all can delete the source files  after  a

backup successfully  completed. The source files will not be deleted if there were errors
or warnings.
 Delete  empty  directories.  After  a  finished  backup,  Backup4all  can  delete  empty

directories.
 Store  local  catalogs.  The  backup  catalog  is  now stored  both  locally  and  remotely  for

backups executed to removable drives or remote destinations.
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 New scheduler (runs as a service). The scheduler now uses Windows Task Scheduler
thus giving more flexibility  to automating the backup task.
 CD/DVD  burning  enhanced.  Backup4all  now  has  two  built-in  CD/DVD  burning

engines  included, in order to give the option to choose which solution fits better.
 Independent  spanned  backups.  If  you  have  a  large  backup  that  spans  over  several

removable  media  (CD/DVD,  floppy)  each  spanned  backup  can  be  independently
restored. Thus, if one of the spanned backups is corrupted you can still restore the other
files.  Also, after each CD/DVD written the backup test is performed (if the test backup
option is enabled).
 Improved  design.  We've modified some of the design elements  for  Backup4all  (menu,

buttons,  icons).  Now  the  user  has  the  ability  to:  toggle  toolbar  buttons  hints  and
captions,  change  visualization  modes  for  Normal/Windows/Scheduler  startup,  change
background color.
 Custom file locations. You can change now the location for the temporary, initialization

(.ini), log and catalog file folder (.bkc).

You  can  install  Backup4all  3  without  uninstalling  Backup4all  2.x.  After  the  installation,
Backup4all  3  will  give  you  the  possibility  to  import  the  backup  jobs/groups  that  you  have
defined  in  Backup4all  2.x  without  additional  re-configuration.  For  more  details  on  how  to
import backup jobs/groups go see the Import help section.

1.5 Features Summary

Intuitive interface
With the help of the file tree, you can see all files included in the backup and the new files that
will  be stored at next backup execution. You can sort and search this file tree. You can start
the application at Windows startup or minimize it to the system tray.
 
Flexibility
Backup4all  is  very  flexible,  allowing  you  to  run  almost  any  backup  operation  you  might
require.
 
Manage multiple backup jobs
You can define multiple backups and save them for future use. On the main form, you have an
overview of all defined backups organized in groups. You can create shortcuts to any backup
job and execute it with a double click from your desktop or other location. Backup4all comes
with  several  predefined  backup  jobs:  My  Documents,  My  Pictures,  Outlook  Express  and
Backup4all  Configurations.
 
Email notifications
You can  configure  Backup4all  to  send  custom  emails  after  a  finished  backup  with  success,
error, warning  notifications.  Additional  options  allow  you  to  attach  the  backup  log  file  and
send the email to several addresses.
AES encryption
Backup4all  supports 128-bit, 192-bit and 256-bit AES encryption. These numbers  reflect  the
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encryption  key  size  used  to  encrypt  the  data,  thus  a  higher  key  size  provides  stronger
encryption.
 
Backup locked or open files
Backup4all  uses the Volume Shadow Copy service that allows you to back up local open files
from  NTFS  partitions  in  Windows  XP/2003/Vista.  Now  you  can  backup  your  emails  and
settings without closing Microsoft Outlook, Outlook Express or other email clients.
 
Create backup shortcut
You can create a "shortcut" of a backup job or backup group to a desired location. Whenever
you will double click that shortcut, the associated backup will start running.
 
Statistics
You can  actually  see  the  number  of  files  that  will  be  processed  at  next  backup  (very  useful
when  you have a  large number of  files).  Other  information refers  to the size  and date  of  the
executed backups and the available free space on storage destination.
 
Summary
Textual description of all configurations made to a backup job.
 
New backup wizard
Provides step-by-step instructions to create a new backup job.
 
Easy file and folder selection
You can browse a folder tree to select individual  files and folders as source of the backup or
you can include or exclude them individually.
 
Backup types
Backup4all  performs four  backup types:  full  backup,  differential  backup,  incremental  backup
and mirror backup.
Backup4all  can also delete the source files (after a backup successfully  completed) and empty
directories.
 
File filters
Powerful  filtering  engine with lots  of  options  (filter  by  attribute,  size,  date,  name  and  type).
You can build filters using a combination of restrictions and you can define separate filters for
inclusion  and exclusion.
 
Built-in scheduler
You  can  easily  set  up  a  powerful  scheduler  using  the  available  scheduler  configurations  to
make unattended backups.
 
Extra actions
Perform extra actions before and/or after the backup execution.
 
Test backup
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The application tests the backups (using CRC32). This ensures that the files have been backed
up properly and the backup is safe. You can also test the backup integrity at a later time from
the application main menu.
When  backing  up  to  removable  media,  after  each  media  item  written  the  backup  test  is
performed (for spanned backups).
When  backing  up  to  FTP,  the  XCRC  command  can  be  used  (if  supported  by  server).  This
speeds  up  the  testing  as  Backup4all  will  verify  the  backup  based  on  the  CRC  information
received from server.
 
Standard zip compression
Backup4all  creates  standard  zip  files.  This  means  that  your  data  is  not  at  the  mercy  of  the
utility  itself; you can access it with any zip compatible utility.
 
Customized zip names
You  can  customize  name  prefixes  for  the  zip  archives,  which  store  your  backup  versions.
Backup4all  also supports file/folder paths longer than 260 characters (turn off file parsing).
 
Password protection
You can protect your zip files by setting a password for each backup.
 
Snapshots
The mirror backup type makes an exact copy of selected files and folders.
 
Disk spanning
Automated support  for  splitting your backup between many removable  disks  or  even  on  the
same media. You can specify the maximum size of the zip archives.
When  performing  a  mirror  backup  and  using  disk  spanning  you  can  choose  not  to  split  the
files.  This is an useful option because you can copy your music/movies to CD or DVD and not
have them trimmed when the CD or DVD is full.
 
Multi-thread
Backup4all  allows you to start more backups at the same time, to execute a  whole group of
backups at once, showing the progress of each backup.
 
Logs
The operations performed by Backup4all are logged. You can change the location of the log
file  if you want to store it in a different place.
 
Command line
There  is  a  command  line  version  of  Backup4all  available.  You  can  use  the  "Backup4all
Scheduler" to schedule backups.
 
Restore wizard
Restore backed up data step-by-step. Allows you to choose the version of files which will be
restored and filter them to restore only the files that are needed.
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Restore
You can quickly restore any file version, the latest version of the files or a whole folder from
the backup job.
If you have a large backup that spans over several removable media (CD/DVD, floppy) each
spanned  backup  can  be  independently  restored.  Thus,  if  one  of  the  spanned  backups  is
corrupted you can still restore the other files.
 
Compatibility
Restore can also be performed via any standard zip software, giving you more flexibility,  if you
need  to restore on a  different  computer  (if  the backup was created  using  independent  splits,
see this section on how to restore correctly using 3rd party zip utilities).
 
One touch backup
Some USB enclosures have a button to start  the execution of  an associated program. If  you
have such a device, you can configure Backup4all to execute a backup job or a backup group
when this button is pressed.
 
Play custom sounds
Backup4all  can play custom success/warning/error sounds at the end of the backup.
 
File warnings
File  warnings  like  access  denied,  locked  files,  etc.  are  displayed  to  the  user  during  backup
execution  if  the  user  chooses  so.  These  warnings  are  also  written  to  the  log  file.  Scheduled
backups do not show these warnings even when this option is set. Default is checked.
 
Backup catalog
Backup4all  stores a summary snapshot of the file information into a backup catalog file (.bkc)
each  time a backup job is run. For every file backed up, the snapshot contains the file  name,
size  and  attributes  as  well  as  the  date  and  time  of  creation,  modification  and  access.  The
backup catalog is stored both locally and remotely (for backups to removable media or remote
locations).
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2 Getting Started

2.1 How to Configure a New Backup?

To create a new backup job, click on the New Backup Wizard  toolbar button ( ). For
each backup job you must specify at least its name, source files and a valid storage destination
(first three steps of this wizard), the rest of the options not being mandatory.
 
These are the steps you must perform in the New Backup Wizard:

1) General  - Enter the name of the backup in the Name  field, select a group or define a
new  one  and  choose  the  predefined  backup  type  (or  leave  None  to  create  a  new
backup). Click Next to go to the following step.

2) Sources  - Select the files and folders you want to backup (sources of the backup) and
click Next



Getting Started 17

Backup4all 3 User Manual Copyright © 2007 Softland

3) Destination - Select a destination for the backup (where the source files will be stored)
and click Next. You can choose as destination your local hard drive (Local), a network
computer (LAN) or an FTP destination (FTP).
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4) Type  -  Select  the  type  of  the  backup  (full,  incremental,  differential  or  mirror),  set
backup type and ZIP compression related options and press Next.

5) Filters  -  Filter  the  source  files  indicating  what  files  and  folders  to  be  included  or
excluded from the backup.

 

6) Advanced  -  Set  advanced  options  for  the  Backup,  Actions,  Sounds  and  Emails
sections  (like  comparison  criteria,  automatic  test,  actions  before  or  after  the  backup,
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sounds, email notifications etc.) and click Next.

 

7) Scheduler - Schedule the backup job for unattended backup executions.

 

Backup4all  provides  extended information  about  the  backup,  which  can  be  consulted  before
the backup execution. You can switch between views by pressing the following buttons from
the application toolbar:
 

 Explore - shows the source files  and folders for the backup job
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 Statistics - shows statistics about the latest backup and the next backup job

 Summary - shows configuration information about the backup
 
The wizard creates an ".ini" file in the IniFiles  folder  (usually  in  C:\Documents  and Settings
\<user>\Application  Data\Softland\Backup4all  3\)  with the  same  name  as  the  backup  job.  In
addition,  a  backup  catalog  file  (".bkc")  is  created  both  in  the  destination  and  locally  in  the
BkcFiles  folder (same directory where the IniFiles folder is created).
 
Manually  modifying  ".bkc"  or  ".ini"  files  may  result  in  corrupted  backup  jobs  and  the
impossibility  of restoring the data you backed up. A backup job is automatically created when
double clicking on a ".bkc" file. You can also recreate the backup job by opening a ".bkc" or ".
ini"  file from the File->Open Backup menu.
 
Once the backup job is  created,  it  will  be  displayed on the left  side of  the application's  main
window. On the right, you will see the content of the backup job (files and folders), depending
on the chosen view.
 

2.2 How to Run a Backup Job?

To start a backup click the Backup  button ( )  from the application's  toolbar  or  press
F6.

During the execution of the backup, you will see a Backup image appear in front of the icon
chosen for the backup job. If the backup is finished successfully  (without errors and warnings)
this image will disappear restoring the initial view of the backup jobs' icon.

 

If one or more files could not be backed up (not enough user rights etc.), then the Warning
icon  appears  in  front  of  the default  backup job icon,  after  the backup finished.  Read the  log
files  (from  View->Job  Logs->Last  Backup  log)  for  details  about  the  files  that  were  not
backed up. The Warning  icon will disappear when the backup is executed again and all files
were backed up.

 

If  an  error  occurred  during  backup  and  the  backup  was  aborted,  the  Error  icon  appears  in
front  of  the  backup  job.  Read  the  log  files  (from  View->Job  Logs->Last  Backup  log)  for
details  about  the errors.  The icon will  disappear  when  the  backup  is  executed  again  and  the
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execution is successful.

 

2.3 How to Manage Backup Jobs?

Copy an Existing Backup Configuration

You  can  use  the  Create  Like  button  ( )  from  the  application's  toolbar  to  create  a
duplicate of the selected backup job and after that you can easily modify its configuration.
 
 
Modify a Backup Job Configuration
First  you must select the backup job you wish to modify. Then press the Properties  button (

)  from the  application's  toolbar.  This  will  open  the  Backup Properties  window.  You
can  also  change  its  configuration  by  choosing  Properties  from  the  right-click  menu  of  the
backup job. After the Properties window is opened, go to the page with the settings you want
to modify.
 
 
Delete a Backup Job

Select  the  backup  job  you  want  to  delete  and  click  the  Delete  button  ( )  from  the
application's  toolbar. Another possibility  is to choose Delete  from the right-click menu of the
backup job.
Files  and  folders  from  the  source  and  destination  will  not  be  deleted,  by  any  of  these
operations.
 

2.4 How to Restore from a Backup?

With Backup4all you can do the following restore operations:
 full  restore
 filtered restore
 restore all files from a folder
 restore the latest version of a particular file
 restore the latest version of multiple selected files
 restore any version of a particular file

To make a full or a filtered restore start the Restore Wizard by pressing the Restore  button (
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) from the application's toolbar. You can restore to the original location or to a different
location of your choice.
 
You can restore the latest version of  a  file,  several  selected files  or  all  files  from a folder  by
selecting  the  files  or  folder  in  the  Explore  View,  right-click  and  select  Restore  Latest
Version or Restore Latest Version To...

 
If you want to restore a particular file version, switch to the Explore View, select the targeted
file  in the tree, right-click on a file version from the bottom list and choose Restore or Restore
to...

 

Beside  files, folder  information is also added to backup, so a restore process can recreate the
original  folder structure.

2.5 How to Test a Backup?

With Backup4all you can:
 test one or more versions of a backup (you can select any version for testing)
 automatically  test latest version of a backup at each backup job execution

To  test  a  selection  or  all  the  versions  for  the  selected  backup  job,  open  the  Test  Backup
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window  by  pressing  the  Test  button  ( )  from  the  application's  toolbar  (or  using  the
keyboard shortcut F9). 

 

In the test window, select the backup versions you wish to test and press the Test button. You
can  also  modify  the  priority  of  the  test  process  by  moving  the  slider  to  a  lower  or  higher
priority  (default  is  Normal).  A  High  priority  process  finishes  faster  but  consumes  more
resources than a Normal priority process.
 
While  performing  the  operation,  a  Test  icon  appears  in  front  of  the  icon  of  the  backup  job
being tested.

To  be  sure  the  test  automatically  runs  after  each  backup,  you  should  open  the  Backup

Properties  window by pressing the Properties  button ( ) from the application's toolbar
and in the Advanced tab make sure the Test after backup option is checked.
 
If  the  test  was  executed  automatically  after  backup  and  it  failed,  the  Error  icon  appears  in
front of the backup job icon. Read the log file for details about the errors (View->Job Logs-
>Last Test log). The icon will disappear when the backup job will be successful.
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2.6 How to Password Protect a Backup?

Passwords are used to protect your backup files from unauthorized access.
 
Setting the Password
 
The  Encryption  Settings  window is  shown when  pressing  the  Encryption  button  from the
Type page of the Backup Properties window or from the New Backup Wizard. The button
is available only for full, incremental and differential backup types (not for mirror).
 
By default the No encryption option is selected.
If you want to protect your backup, you can choose the type of the encryption to be used.
The  Zip(2)  compatible  encryption  offers  moderate  security  but  is  compatible  with all  third
party zip applications.
 
The  best  choice is  the AES encryption  which  is  the  new standard  in  ZIP  protection,  but  is
recognized only by the latest version of third party zip applications (like Winzip or PKWare).
Backup4all  supports AES encryption  in 3 different  key strengths:  128-bit,  192-bit  and 256-
bit. These numbers reflect the size of the encryption keys used to protect the data - the higher
the  number  the  stronger  the  encryption.  All  three  types  provide  higher  security  than  the
password protection method.
When  choosing  a  password,  it  is  recommended  that  you  use  a  combination  of  letters  and
numbers and at least a 6 character long password.
 
You  should  manually  enter  the  password  in  the  New  password  field  and  re-enter  it  in  the
Confirm new password field to avoid typing errors.
The Old password field is enabled only when the backup job already has a password. You can
change the password only if you enter the old one in this field. This way only the owner of the
backup will be allowed to change the password.
 
The  system  makes  it  possible  to  set  different  passwords  for  the  same  backup  job,  so  the
backup may contain zip files with different passwords. Backup4all does not store passwords.
Make sure that you remember all passwords that have been used for a backup job, or you will
not be able to restore your files.
 
 
How to Remove the Password?
 
In the Encryption settings window select the No Encryption option and enter the password
that  you  used  in  the  Old  password  field.  You  cannot  remove  the  password  if  you  don't
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provide the old one.
If you have the Zip(2) compatible encryption  or AES encryption  option selected, you can
also  remove the password by entering the Old password  and  leave  the  New password  and
Confirm new password fields empty.
 
 
Using Passwords when Restoring
 
During  the restore process of backups with password protection, the Enter Password  dialog
will  appear.  Enter  the  password  and  press  OK.  If  you  do  not  know  the  password  for  this
backup number you can:
 press Skip backup to go to the next archive - the restore may be incomplete in this case.
 press  Stop restore  to stop the whole process  -  the restore will  be incomplete,  because

only a part of the files were restored.

2.7 How to Schedule a Backup?

You  can  schedule  a  backup  either  from  the  Backup  Properties  window  or  from  the
Schedulers window.
 

Open  the  Backup  Properties  window  by  pressing  the  Properties  button  ( )  from  the
application's  toolbar  and  select  the  Scheduler  section,  or  open  the  Schedulers  overview

window by pressing the Scheduler button ( ).
 
The difference between the two methods is that the first  displays the scheduled tasks only for
the selected backup job, while the second will show you the scheduled tasks for all the backup
jobs and groups.
 
Backup4all  uses  by  default  the  Windows  Task  Scheduler  in  order  to  run  the  scheduled
backups  so  you  need  to  make  sure  that  the  Task  Scheduler  service  is  enabled  on  your
computer. Use the Windows  Help in  order  to  find  out  more  information  about  scheduling  a
task using the Task Scheduler. If you don't want to use the Windows Task Scheduler, you can
use Backup4all's standalone scheduler by selecting Use Standalone Scheduler.
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In  order  to  add  a  new  scheduled  backup  press  the  Add  button  and  select  the  needed
configuration in the newly opened window.
If your user account has a password make sure that you enter it by pressing the Set Password
button. We do not save your password but it is needed in order to set up the scheduled task in
the Windows Task Scheduler.
If  your user account does not have a password you must select the Allow blank passwords
when scheduling option from the General page in the Tools->Options window.
After  defining  the  scheduled  backup  you  must  set  its  run  time  by  pressing  the  Schedule
button. If you skip this step the default Windows value will be used (usually is Daily at 9:00
am).  Use  the  Windows  Help  in  order  to  find  out  more  information  about  scheduling  a  task
using the Task Scheduler.
 

2.8 How to Backup to USB Drives?

You can backup your data to a USB drive or  from a USB drive using Backup4all.  This  is  a
practical  backup  destination  as  it  allows  you  to  store  important  files  to  external  devices,
offering  increased portability. It can be considered as an additional protection against data loss
as the result of hardware failure or other disasters.

There are external USB hard drives with performance comparable to conventional hard drives.
These portable drives (called enclosures) are composed of devices that connect through USB
on one side and to conventional hard drives on the other side. A hard drive is installed into the
enclosure  and then the enclosure is  plugged  into  the  computer,  thus  creating  a  normal  USB
backup device. Given the size of nowadays hard drives, this can be considered a mass storage
device for backup purposes.

There  are  external  hard  drives  that  beside  the  USB  technology  use  also  FireWire  as  a
connection port. On one side FireWire hard drives tend to have increased speed over USB, but
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on the other side USB ports are more common on computers.

Steps in backing up to USB drive with Backup4all:
1) Start  your USB device.  Before starting  the  backup  process  make  sure  that  the  USB

drive  is  started  and  working.  Usually  the  enclosure  should  have  a  start  button  and
display  the status of the drive using led displays. When it is started a green led should be
lighted.

2) Make sure your drive is  formatted.  If  you have just  purchased  the  drive  and  didn’t
use it yet, you might have to format it (only if you didn’t use it before, since formatting
will  erase everything from it). Formatting the USB drive in Windows XP:
 Go  to  Start->Settings->Control  panel->Administrative  tools-  >Computer

Management.
 Under  Computer  Management  click  Disk  Management  then  check  the  right-

bottom window (scrolling down if necessary)
 You  should  see  the  additional  hard  drive  disk;  right-click  on  it,  choose  New

partition, then follow the instructions to format the hard drive.
 Test  to see if the drive is now recognized by going to Windows Explorer  (a new

drive letter should appear)
3) Configure Backup4all. If the drive is formatted and recognized by Windows, it will be

recognized  by Backup4all too. Now, to backup to the USB drive you should define a
backup job in Backup4all that has the destination set to the USB drive. To ensure this,
please  select  the  backup  job  you  want  to  run,  press  CTRL+P  in  order  to  open  the
Backup Properties  window,  go  to  the  Destination  page  and  select  a  drive  from the
Destination  drive  drop  down  list.  You  can  also  define  a  new  backup  job  and  in  the
destination window select the USB drive.

Some USB drives have a button to start the execution of an associated program. If you have
such a device you can configure Backup4all to execute a backup job or a backup group when
the  button  is  pressed.  After  the  USB  drive  is  ready,  go  to  the  Tools->Options  menu  of
Backup4all,  select  One  Touch  Backup  and  press  Detect  to  check  if  the  USB  drive  is
compatible  with the One Touch Backup feature of Backup4all.

2.9 How to Send Email Notifications?

Send Email  notifications  is  a  very  useful  feature  that  enables  Backup4all  to  send  an  email
with information about the status of the performed backup job upon its completion.
 
 
Enabling email notifications:

1) Open Tools->Options->Email 
2) Check the Enable email notifications box
3) Enter the following details:
 Dial-up connection  -  if  you  are  using  a  dial-up  connection  select  from the  drop-

down  box  a  method  that  Backup4all  should  use  to  be  able  to  send  emails:
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automatically  connect (it will connect without user assistance) or manually  connect
(it will require user assistance to enable the connection).
 Email addresses - you must specify the email address used to send the email (From

field)  and optionally a Reply To email address
 SMTP  Server  -  specify  the  name  or  IP  address  of  the  SMTP  server  used  for

sending  the  mail  (example:  smtp.novapdf.com)  in  the  Name/IP  field  and  a  Port
number for it (usually is 25); you can also Secure Socket Layer when connecting to
the SMTP server.
 Authentication  -  if  the  SMTP  server  requires  authentication  check  the  Server

requires authentication box and enter an user name and a password.
4) Click  on the Send Test  Email  button and enter  the email  address  where you want  to

receive  the  notification.  Once  you  press  OK  you  should  receive  a  test  email.  If  you
didn't receive it, you must revise the settings you configured.

5) Press OK to save your settings

Sending email notifications
 
You have to enable separately for each backup job the option to send emails. To do so follow
these steps:

1) Select  a  backup  job  and  open  the  Backup Properties  window (right  click  and  select
Properties or Ctrl+P)

2) Go to the Advanced tab and click on Emails
3) Enable the option Send email notification
4) Optionally  you can edit the default emails sent and also to attach the backup log to the

email
5) Press the Save button to save your changes

2.10 How to Configure One Touch Backup?

Some USB enclosures have a button to start  the execution of  an associated program. If  you
have such a device, you can configure Backup4all to execute a backup job or a backup group
when this button is pressed. If your One Touch Backup device is not detected by Backup4all
(Backup4all  is  not  natively  compatible  with  the  device),  you  could  use  the  command  line
parameters  to  create  a  command  that  can  be  associated  to  the  One  Touch  button  of  your
device. See this section for details.
 
If the One Touch Backup option is enabled when the application starts and there is no backup
job or backup group set to be executed when the One Touch button of the USB enclosure is
pressed,  the user  will  be  asked  to  choose  one  from the  options  displayed  in  the  One  Touch
Backup dialog:
 Create a new backup job for One Touch Backup.  If you select this, the New Backup

Wizard  will start and you can create a new backup job to be used with the One Touch
Backup feature
 Select  an existing backup job  or  backup  group  for  One Touch  Backup.  If  you  select
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this,  the  One  Touch  Backup  section  of  the  Options  window  will  open  and  you  can
select the backup job or group you want to use. This option is disabled when there is no
backup job to select.
 Disable  this feature (you can activate it back at any time from Options). This will disable

the One Touch Backup feature. You can activate it again from the One Touch Backup
section of the Options window.

If you press Cancel, Backup4all will open, but when you will press the One Touch button of
the USB device the same dialog will be displayed. This dialog will appear again if the backup
job (executed when the One Touch button is pressed) was deleted.
 

2.11 How to Use One Touch Backup?

You enable the One Touch Backup support from the Options  window. At first run there is
no backup job configured to execute when the One Touch button is pressed, so you will have
to configure it as explained in the How to Configure One Touch Backup? tutorial.
 
Once  everything  is  configured,  you  will  just  have  to  push  the  One  Touch  button  and  the
selected backup job or backup group will be executed.
 
If Backup4all is not started, it will start automatically. If it is already started, but minimized  it
will  show a pop-up window or the main window while backing up (depending on the settings
from the Options window).
 
When  the  backup  finishes  Backup4all  is  minimized,  if  the  Hide  when  finished  option  is
checked. If the main window of the application was already open when the One Touch button
was pressed, the Hide when finished option will be ignored.
 

2.12 How to Enable Detailed Logging?

Backup4all  allows  you  to  log  detailed  information  about  the  operations  executed  (backup,
restore or  test).  Practically,  this  means  that  beside  the  warnings  and  errors,  the  log  file  will
contain detailed information about all files handled by the backup, restore or test process.
 
To enable detailed logging:

1) Go to Tools menu and open the Options window
2) Switch to the Logging page
3) Check the Log detailed information option
4) Check  the   Include  summary  in  log  option  (this  will  include  in  the  log  file  all  the

information  available from the Summary view)
5) Additionally  you can limit the size of the log folder too. Just select in the Restricted to

section the maximum values you want to allow the log folder to grow to.
6) Click OK to close the window and save the changes
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3 FAQ

3.1 Using Backup4all

1. How can I create a new backup job?
Backup jobs are created by the New Backup Wizard. The wizard can be started from the File

menu or by clicking the New Backup Wizard button (  ) from the toolbar or the Ctrl+N
 keyboard shortcut. Follow the steps of the wizard and click Finish when ready.

2. How can I copy a backup job (create a new one similar to another)?
Select  the backup job you want to copy from the list  of  available  backups.  Click the Create

Like button (  ) or Ctrl+L. The new backup job will be added to the same group as the
original  one.

3. How can I see only new and modified files in the Explore view? How can I  see only
the files already backed up?

First you need to switch to the Explore View. Click the Explore button (  ) or F2.
To show only new and modified files make sure that:

 Show New Files   is pressed (Ctrl+1)

 Show Unchanged Files  is not pressed (Ctrl+2)

 Show Modified Files  is pressed (Ctrl+3)

 Show Excluded Files  is not pressed (Ctrl+4)

 Show Deleted Files  is not pressed (Ctrl+5)

To show only the files already backed up make sure that:

 Show New Files   is not pressed (Ctrl+1)

 Show Unchanged Files  is pressed (Ctrl+2)

 Show Modified Files  is pressed (Ctrl+3)

 Show Excluded Files  is pressed (Ctrl+4)

 Show Deleted Files  is pressed (Ctrl+5)
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4. How can I hide empty folders in the Explore View when expanding all folders?
Open  the Options  window, go to the General  page  and  check  the  Hide  empty  folders  on

expand all  option. After this option is set, the Expand All  operation (  ) will  not  show
empty folders.
Note: Expanding all folders can be time consuming,  especially  if  you add the whole drive as
the source of the backup. You can always stop pressing the ESC key., empty folders will not
be shown any more.

5. How can  I  see  the  number  of  files  to  backup at  next  backup  run?  What  about  the
number of changed files since latest backup?

First you need to switch to the Statistics view by clicking the Statistics button (  ) or F3.
Press the Calculate Statistics for Next Backup button or Ctrl+F5.  Wait until  the file count
finishes.  The results are shown in the text below. The left column shows the counters for files
to be  backed  up  and  the  right  column  shows  the  counters  for  files  changed  since  the  latest
backup.
 
6. Somehow I lost my backup job configuration. I only have the .bkc file. Can I restore

the backup job?
Yes, you can. Just double-click on the ".bkc" file. Backup4all will open and a new backup job
will  be created based on the information from the backup catalog ".bkc" file.
 
7. How can I make a shortcut to a backup job, so that I can run it from the desktop?
First  select the backup job you want to run. Right-click on it and select the Create Shortcut
menu item. Save the shortcut to the desktop.

8. How can I run a backup when I am not logged in to Windows?
First you will have to create a shortcut to the backup job you want to execute. Open Windows
Scheduler and add a new scheduled task. Schedule the shortcut to be run at the time you want
and use your Windows username and password. For more information on using the Windows
Scheduler, see Windows help.
 
9. Zip files created by Backup4all are compatible with third party zip utilities?
Yes.  If  the  zip  file  size  is  less  than  2  gigabytes,  Backup4all  generates  standard  zip  formats.
This format is compatible with any zip utility available on the market. For zip files greater than
2  gigabytes,  Backup4all  uses  zip64  technology  (which  allows  unlimited  zip  file  size).  Zip
compatibility  means that your data is not at the mercy the backup application; you can access it
with other third party applications also.
 
10.How does Backup4all handle archive bit for backed up files?
By default Backup4all does not modify the archive flag. Backup4all uses its own catalog file
(".bkc")  to  keep  track  of  the  new  and  changed  files.  The  advantage  of  a  catalog  is  faster
backup  execution.  Another  advantage  is  that  you  can  run  Backup4all  together  with  other
backup applications because they will not  interfere  with each other.  However  if  you want  to
set the Archive bit, you can do that from the Type page of the Backup Properties window.
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11.Can I backup to tape using Backup4all?
No. The current version does not support tape drives.
 
12.Can I backup open files with Backup4all?
Yes you can backup open or locked files with Backup4all as long as your system meets some
requirements:
 you have Backup4all version 3 (or higher) installed
 you are using Windows XP, Windows 2003 Server or Windows Vista
 the files reside on local NTFS partitions (will not work on shared network drives)
 the Volume Shadow Copy service is running

 
13.Can I backup registry files?
Yes  you  can  backup  registry  files  with  Backup4all  as  long  as  your  system  meets  some
requirements:
 you have Backup4all version 3 (or higher) installed
 you are using Windows XP, Windows 2003 Server or Windows Vista
 the files reside on local NTFS partitions (will not work on shared network drives)
 the Volume Shadow Copy service is running

Note that you cannot restore registry files for now (restore function will be included in a future
version).
 
14.Can I backup Outlook Express emails and settings?
If  you  are  using  Backup4all  3  (or  higher)  on  Windows  XP/2003/Vista  you  can  backup
Outlook Express emails and settings if it is installed on a NTFS partition. When you define a
new  backup  job  using  the  New  Backup  Wizard,  in  the  General  window  you  can  select
Outlook Express from the Predefined Backup box. This way Backup4all will  automatically
backup  all  your  emails  and  settings  from Outlook  Express  (including  your  account  settings,
rules,  signatures, blocked senders list, stationary,  address  book).  If  you want  to backup only
your emails, in the Sources window leave marked only the <Email Folders> box.

15.How do I restore the default layout for all Backup4all windows?
Open  the  View  menu  and  select  Restore  Default  Layout.  This  will  restore  all  windows  to
their  original size and position, and will also reset the column order, size and visibility  for all
grids. 

16.Which Operating Systems are Compatible with Backup4all?
Backup4all  is  compatible  with  Windows  98/ME,  Windows  2000,  Windows  XP,  Windows
Server 2003, Windows 2003 Small Business Server, Windows NT 4.0 systems and Windows
Vista.  It  is  not  compatible  with  Macintosh  and  Linux  systems  (you  can  however  try  using
emulator software for MAC, such as Virtual PC 2004, or for Linux, such as Wine).
 
17.What security offers Backup4all for my backups?
Backup4all  supports  AES encryption (128-bit,  192-bit  and  256-bit  key  strength),  one  of  the
most secure encryption methods available.
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If  you  want  your  backups  protected,  select  one  of  the  Encryption  methods  available  and
define a password of at least 6 characters:
 Zip (2) compatible encryption  is less  secure,  but  the zip files  resulted are  compatible

with most of the ZIP utilities.
 AES encryption  provides  high  security,  but  the  zip  files  resulted  are  compatible  only

with the latest version of the ZIP compatible utilities.
Be  sure  not  to  lose  the  password,  because  if  you  are  using  AES  encryption  is  almost
impossible  to recover it, thus the data in that backup. When you’re backing up to FTP you also
have  the  option  to  use  an  additional  SSL  encryption  when  communicating  with  the  FTP
server; using this option your connection details will be sent to the FTP server in an encrypted
form rather then in simple text.

18.What happens when I change the backup type?
Backup type can be changed from the Type page of the Backup Properties window. You can
change  between full,  incremental and differential  backup types without having to start with a
fresh new backup. However changing from full, incremental or differential to mirror (and vice-
versa) will clear the backup content and will start a new backup.
 
19.How can I set the compression level of the zip files?
Open Backup Properties, go to the Type page and press Zip Advanced Settings. Here you
can choose from four compression levels: none, low, medium or high.
 
20.How can I split a backup across several disks?
Open  Backup  Properties,  go  to  the  Type  page  and  press  Advanced.  You  can  choose  a
predefined  split  size  or  define  a  custom  one.  Spanning  is  automatically  done  when  the
removable  disk is full.
 
21.How can I give customized names to the zip files?
Open  Backup  Properties,  go  to  the  Type  page  and  press  Advanced  button.  You  can
customize the zip file name prefix there.
 
22.I have used Backup4all for some time now and I have a large number of zip files in

the destination. How can I clear them and start over again?
Open the Backup Properties window for the backup job. Go to Advanced page, check Run
program/action  before  backup  and  choose  <Clear  backup>  from  the  combo.  This  will
delete the backup files in the destination before the execution of the backup job. If you check
the Run only once  option,  the <Clear  backup>  action  will  be  executed  only  once  (at  next
backup  execution)  and  after  that  it  will  be  disabled.  The  <Clear  backup>  action  has
parameters to further customize its functionality.
 
23.I am using incremental backup. How can I clear all backed up files and start with a

fresh full backup every 7 days?
Open Backup Properties  dialog for the backup job. Go to the Advanced  page,  check Run
program/action before backup, choose <Clear backup> from the combo box and edit it to
<Clear  backup d=7>. This will clear the backed up files only if 7 days passed since the first
backup run. If you check the Run only once option, the <Clear  backup d=7> action will be
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executed only once (when 7 days have passed) and after that it will be disabled.
 
24.How can I limit the number of backup versions?
Open the Backup Properties window for the backup job. Go to the Type page. Here you can
set the Limit number of stored backups to option and specify the desired limit.
 
25.How  can  I  store  many  versions  of  my  files  and  keep  the  backup  size  as  small  as

possible?
Our recommendation is to use incremental backup type with maximum zip compression. The
incremental  backup type ensures that only new and modified files are backed up.
 
26.How can I run a backup using the command line?
Command  line works with a backup job configuration file (".ini") or a backup catalog file (".
bkc"). You can create a valid ".ini" file from Backup4all's interface and use the full path to this
file  as a parameter of the command line application. Typically the ".ini" files are located in the "
Application  Data\Softland\Backup4all  3\IniFiles\"  folder  of  your  user  profile.  After  the  first
backup execution, a ".bkc" file is created in the destination. You can use this ".bkc" file  also
(again with the full path) as parameter of the command line application.
 
27.How can I create backup versions with mirror backup?
Backup4all  can copy the files  to different  folders  each time  the  mirror  backup  is  performed.
This  is done by customizing the destination folder name. To do this open Backup Properties
and  go to the Type  tab.  Customize  the  subfolder  names  as  you  wish.  Note  that  Backup4all
does  not  keep  track  of  all  destination  folder  names  and  can  restore  only  from  the  latest
destination  folder.  However  you  can  manually  restore  an  older  backup  version  made  with
mirror backup.

28.Is there a way to test (verify) files automatically after each backup?
Yes, there is. Open the Backup Properties window, and set the Test after backup option on
the Advanced page.

29.How can I test older backup versions?
First  select the backup job you want  to test.  From the Actions  menu and choose Test.  This
will  show a list of all backup versions. Select the backup version you want to test and click the
 Test button.

30.I've set a password for the backup and I forgot it. Can you help me get it back?
We don’t have any solution to recover your lost password.
If  you  used  Zip(2)  compatible  encryption  you  could  try  using  a  3rd  party  zip  password
recovery application - depending on the length of your password there is a chance to recover
your password.
If you used AES encryption it’s almost impossible to recover your password.

31.I scheduled a backup job and it didn’t execute. What is the problem?
This happens usually when you are logged in to Windows using a username/password but you
didn’t  set a password in  the Backup4all  Scheduler.  To enter  the password for  the scheduled
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job go to Tools->Schedulers , select the scheduled job that didn’t run and click on Edit. In the
window  that  opens  click  on  Set  password  and  enter  the  password  for  the  current  logged  in
user. We do not save your password but it is needed in order to set up the scheduled task in
the Windows Task Scheduler.
If  your user account does not have a password you must select the Allow blank passwords
when scheduling option from Tools->Options->General .
Also, make sure that you enter the correct password - if the password is wrong the scheduled
task will not run.

32.Can I apply a filter to an entire directory?
Yes you can apply filters to entire directories. This way the filter will apply to the subfolders
and individual files of the filtered directory too:
 in  the  Filters  window  of  the  backup/restore  wizard  click  on  Add  (in  the  include  or

exclude filter) to open the Edit file filter item window
 check the option Filter by name and Filter folder names also
 in  the  Filter  field,  enter  the  directory  name  that  you  want  to  filter  in  the  following

format:  *\directory_name\*.  Backup4all  will  apply  the  filter  to  all  the  directories  that
are  called  directory_name.  If  you  want  to  apply  the  filter  to  directories  containing  a
specific  word,  you  must  enter  it  in  the  following  format  *\*keyword*\*.  Now
Backup4all  will apply the filter to all the directories that have the word keyword in their
names. Once you've written the desired combination, press on Add and then Ok to apply
the filter.

33.How do I back up my scheduled jobs' settings?
If  you  scheduled  several  backup  jobs  using  the  Windows  Task  Scheduler  (by  default
Backup4all  uses it) you can back up those scheduled tasks so that  if  something happens you
would be able to easily restore them.
Information  about  the  scheduled  tasks  is  saved  in  the  Windows  directory,  "Tasks"
subdirectory. To back up the scheduled backup jobs' settings you would have to copy all files
starting with "B4A_" from "C:\Windows\Tasks".

34.Backup4all skipped some files when backing up and returned the error "The process
cannot access the file because another process has locked a portion of the file". How
can I fix this?

Backup4all  uses the Volume Shadow Copy Service (VSS) to back up open/locked files. Under
certain circumstances the VSS service fails to run properly and Backup4all will not be able to
backup  some  locked  files  (log  file  will  show  “The  process  cannot  access  the  file  because
another  process  has  locked  a  portion  of  the  file.”  or  “The  process  cannot  access  the  file
because it is being used by another process”).
In case of such errors please read carefully and follow the solutions given in the following PDF
file  to  try  and  fix  the  VSS  service  problem:  Troubleshooting  the  Volume  Shadow  Copy
Service

35.How can I restore one or more files?
To restore the latest version of one file you need to select the file from Explore  view,  right-
click on it and select Restore Latest Version or Restore Latest Version To... If you want to

http://www.backup4all.com/download/pdf/Volume-Shadow-Copy-Service.pdf
http://www.backup4all.com/download/pdf/Volume-Shadow-Copy-Service.pdf
http://www.backup4all.com/download/pdf/Volume-Shadow-Copy-Service.pdf
http://www.backup4all.com/download/pdf/Volume-Shadow-Copy-Service.pdf
http://www.backup4all.com/download/pdf/Volume-Shadow-Copy-Service.pdf
http://www.backup4all.com/download/pdf/Volume-Shadow-Copy-Service.pdf
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restore more than one file,  you can select  all  of  them in  Explore  view and restore the latest
version using the right-click menu (as mentioned above).

36.How can I restore an older version of a file?
To restore an older version of a file you need to select the file from Explore view. Then look
for available versions in the list displayed below the file and folder tree. Select the version you
want to restore, right-click on it and choose Restore or Restore to...
 
37.How can I restore many files from older backup versions?
Sometimes we need to restore files from an older backup version. To do this open the Restore

Wizard by clicking on the Restore ( ) button, select the custom Restore type and click
Next. Now the list of available backup versions is shown. You can select one or many versions
(use the SHIFT and CTRL keys to define the selection). In the next pages you can apply file
filters  or  individually  select  each  file  from  the  selected  versions  that  you  actually  want  to
restore.

38.How can I restore everything?

Open  the Restore  Wizard  by clicking  on the Restore  ( )  button.  Select  the  standard
Restore type and click Finish.

39.How  can  I  restore  my  files  to  a  different  folder?  How  can  I  filter  the  files  to  be
restored?

Open  the  Restore  Wizard  by  clicking  on  the  Restore  ( )  button.  To  restore  to  a
different  folder, select Choose another location option and enter the full path where you wish
to restore the files, or browse to a folder of your choice. To filter the files that will be restored
define your filters on the second page (or the third page in case of a custom restore).
 
40.What happens to excluded files? Will they be restored?
No, excluded files will not be restored. After all that is why you excluded them, you no longer
need the files. However if you select a backup version where the file was not excluded yet, you
can restore it from there.

41.How can I manually restore a split file from independently created zip archives?
Backup4all  creates  standard  zip  files  that  can  be  extracted  with  3rd  party  zip  programs.
However, when using the Create Independent Splits option and backing up a file big enough
to be split into more than one zip file, you will need to perform an additional operation if you
want to restore that file manually (without using Backup4all).
Steps in restoring a split file from independent zip archives:
 Unzip  the  backup  that  was  created  by  Backup4all.  Assuming  that  the  initial  file  was

called music.wav, if the file was split in 2 parts you'll have 2 files called music1.wav  and
music2.wav  The split files need to be combined so that you have the entire original file,
music.wav.Open the Windows command prompt (Start->Run, type cmd and press Enter
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). 
 Using the command copy (write copy/? and press Enter to see the help for this function)

write copy music1.wav /b + music2.wav /b music.wav (first two files are the sources, last
file  is the destination) and press Enter. Note that you have to be in the folder where the
source files are in order for it to work.

42.Which One Touch Backup HDD enclosures is Backup4all compatible with?
Some  HDD  enclosures  have  a  button  that  allows  starting  the  execution  of  an  associated
program. If you have such a device, Backup4all might be configured to run a certain backup
job when that button is pressed.

Backup4all  is fully  compatible with all the One Touch Backup HDD enclosures produced by
A-TEC  Subsystem  from  Taiwan.  These  devices  are  natively  recognized  and  work  with
Backup4all  without external configuration. 

Another  reported  device  which  works  with  Backup4all  is  Maxtor  OneTouch.  This  device  is
not natively supported thus requires additional configuration. Maxtor OneTouch comes with a
special  software (Maxtor OneTouch Manager) that can be configured to run a backup job in
Backup4all  when the button is pressed. 

If you have a different OTB HDD enclosure, you might be able to configure Backup4all to run
a backup job when the button is pressed. If the OTB HDD enclosure contains software from
the manufacturer of the device that allows configuring the actions to execute when the button
is pressed, you might be able to configure Backup4all to run on pressing the button.

There are 2 possibilities to run a backup job (or group) from Backup4all when the OTB button
is pressed: 

1. In Backup4all, open Tools -> Options and go to the One Touch Backup page.
Check  the  option  Enable  "One  Touch  Backup"  support  and  select  a  backup  job  or
backup group to be executed when the button is pressed.
Configure  the  software  that  was  included  with  your  OTB  HDD  enclosure  to  run  the
following  command when the button is pressed:
"C:\Program Files\Softland\Backup4all 3\Backup4all.exe" /otb
(command above will open the main application of Backup4all)
OR
"C:\Program Files\Softland\Backup4all 3\b4aCmd.exe" /otb 
(command above will open the command line application of Backup4all)

2. Configure  the  software  that  was  included  with  your  OTB  HDD  enclosure  to  run  the
following  command when the button is pressed:

"C:\Program Files\Softland\Backup4all 3\Backup4all.exe" /r "backup name" 
where "backup name" is the name of the backup job you want to be run.

See the Command Line Parameters for more information about how to run a backup job using
the command line parameters.
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